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~ WARNING ~
Thank you for purchasing automation equipment from Automationdirect.com®, doing business as, 
AutomationDirect. We want your new automation equipment to operate safely.  Anyone who installs or uses this 
equipment should read this publication (and any other relevant publications) before installing or operating the 
equipment.
To minimize the risk of potential safety problems, you should follow all applicable local and national codes that 
regulate the installation and operation of your equipment.  These codes vary from area to area and usually change 
with time.  It is your responsibility to determine which codes should be followed, and to verify that the equipment, 
installation, and operation is in compliance with the latest revision of these codes.
At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical Code, 
and the codes of the National Electrical Manufacturer’s Association (NEMA).  There may be local regulatory or 
government offices that can also help determine which codes and standards are necessary for safe installation and 
operation.
Equipment damage or serious injury to personnel can result from the failure to follow all applicable codes and 
standards.  We do not guarantee the products described in this publication are suitable for your particular 
application, nor do we assume any responsibility for your product design, installation, or operation.
Our products are not fault-tolerant and are not designed, manufactured or intended for use or resale as on-line 
control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear 
facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons 
systems, in which the failure of the product could lead directly to death, personal injury, or severe physical or 
environmental damage (“High Risk Activities”).  AutomationDirect specifically disclaims any expressed or implied 
warranty of fitness for High Risk Activities.
For additional warranty and safety information, see the Terms and Conditions on our website. If you have any 
questions concerning the installation or operation of this equipment, or if you need additional information, please 
call us at 770-844-4200.
This publication is based on information that was available at the time it was published. At AutomationDirect we 
constantly strive to improve our products and services, so we reserve the right to make changes to the products and/
or publications at any time without notice and without any obligation.  This publication may also discuss features 
that may not be available in certain revisions of the product.

Trademarks
This publication may contain references to products produced and/or offered by other companies.  The product 
and company names may be trademarked and are the sole property of their respective owners. AutomationDirect 
disclaims any proprietary interest in the marks and names of others.

Copyright 2019–2022, Automationdirect.com® Incorporated 
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written consent of 
Automationdirect.com® Incorporated. AutomationDirect retains the exclusive rights to all information included in 
this document.



~ ADVERTENCIA ~
Gracias por comprar equipo de automatización de Automationdirect.com®. Deseamos que su nuevo equipo de 
automatización opere de manera segura. Cualquier persona que instale o use este equipo debe leer esta publicación (y 
cualquier otra publicación pertinente) antes de instalar u operar el equipo.
Para reducir al mínimo el riesgo debido a problemas de seguridad, debe seguir todos los códigos de seguridad locales o 
nacionales aplicables  que regulan la instalación y operación de su equipo. Estos códigos varian de área en área y usualmente 
cambian con el tiempo. Es su responsabilidad  determinar cuales códigos deben ser seguidos y verificar que el equipo, 
instalación y operación estén en cumplimiento con la revisión mas reciente de estos códigos.
Como mínimo, debe seguir las secciones aplicables del Código Nacional de Incendio, Código Nacional Eléctrico, y los 
códigos de (NEMA) la Asociación Nacional de Fabricantes Eléctricos  de USA. Puede haber oficinas de normas locales 
o del gobierno que pueden ayudar a determinar cuales códigos y normas son necesarios para una instalación y operación 
segura.
Si no se siguen todos los códigos y normas aplicables, puede resultar en daños al equipo o lesiones serias a personas.  No 
garantizamos los productos descritos en esta publicación para ser adecuados para su aplicación en particular, ni asumimos 
ninguna responsabilidad por el diseño de su producto, la instalación u operación.
Nuestros productos no son tolerantes a fallas y no han sido diseñados, fabricados o intencionados para uso o reventa 
como equipo de control en línea en ambientes  peligrosos que requieren una ejecución sin fallas, tales como operación en 
instalaciones nucleares, sistemas de navegación aérea, o de comunicación, control de tráfico aéreo,  máquinas de soporte de 
vida o sistemas de armamentos en las cuales la falla del producto puede resultar directamente en muerte, heridas personales, 
o daños físicos o ambientales severos (“Actividades de Alto Riesgo”).  Automationdirect.com específicamente rechaza 
cualquier garantía ya sea expresada o implicada para actividades de alto riesgo.
Para información adicional acerca de garantía e información de seguridad, vea la sección de Términos y Condiciones. 
Si tiene alguna pregunta sobre instalación u operación de este equipo, o si necesita información adicional, por favor 
llámenos al  número 770-844-4200 en Estados Unidos.
Esta publicación está basada en la información disponible al momento de la publicación.  En Automationdirect.com 
nos esforzamos constantemente para mejorar nuestros productos y servicios, así que nos reservamos el derecho de hacer 
cambios al producto y/o a las publicaciones en cualquier momento sin notificación  y sin ninguna obligación.  Esta 
publicación también puede discutir características que no estén disponibles en ciertas revisiones del producto.

Marcas Registradas
Esta publicación puede contener referencias a productos producidos y/u ofrecidos por otras compañías.  Los nombres de las 
compañías y productos pueden tener marcas registradas y son propiedad única de sus respectivos dueños.  Automationdirect.
com, renuncia cualquier interés propietario en las marcas y nombres de otros.

PROPIEDAD LITERARIA 2019–2022, AUTOMATIONDIRECT.COM® INCORPORATED
Todos los derechos reservados

No se permite copiar, reproducir, o transmitir de ninguna forma ninguna parte de este manual sin previo consentimiento 
por escrito de Automationdirect.com® Incorprated.  Automationdirect.com retiene los derechos exclusivos a toda la 
información incluida en este documento. Los usuarios de este equipo pueden copiar este documento  solamente para instalar, 
configurar y mantener el equipo correspondiente. También las instituciones de enseñanza pueden usar este manual para 
propósitos educativos.



~ AVERTISSEMENT ~
Nous vous remercions d’avoir acheté l’équipement d’automatisation de Automationdirect.com®, en faisant des affaires 
comme, AutomationDirect. Nous tenons à ce que votre nouvel équipement d’automatisation fonctionne en toute sécurité. 
Toute personne qui installe ou utilise cet équipement doit lire la présente publication (et toutes les autres publications 
pertinentes) avant de l’installer ou de l’utiliser.
Afin de réduire au minimum le risque d’éventuels problèmes de sécurité, vous devez respecter tous les codes locaux et 
nationaux applicables régissant l’installation et le fonctionnement de votre équipement. Ces codes diffèrent d’une région à 
l’autre et, habituellement, évoluent au fil du temps. Il vous incombe de déterminer les codes à respecter et de vous assurer que 
l’équipement, l’installation et le fonctionnement sont conformes aux exigences de la version la plus récente de ces codes.
Vous devez, à tout le moins, respecter toutes les sections applicables du Code national de prévention des incendies, du 
Code national de l’électricité et des codes de la National Electrical Manufacturer’s Association (NEMA). Des organismes de 
réglementation ou des services gouvernementaux locaux peuvent également vous aider à déterminer les codes ainsi que les 
normes à respecter pour assurer une installation et un fonctionnement sûrs. 
L’omission de respecter la totalité des codes et des normes applicables peut entraîner des dommages à l’équipement ou causer 
de graves blessures au personnel. Nous ne garantissons pas que les produits décrits dans cette publication conviennent à 
votre application particulière et nous n’assumons aucune responsabilité à l’égard de la conception, de l’installation ou du 
fonctionnement de votre produit.
Nos produits ne sont pas insensibles aux défaillances et ne sont ni conçus ni fabriqués pour l’utilisation ou la revente en tant 
qu’équipement de commande en ligne dans des environnements dangereux nécessitant une sécurité absolue, par exemple, 
l’exploitation d’installations nucléaires, les systèmes de navigation aérienne ou de communication, le contrôle de la circulation 
aérienne, les équipements de survie ou les systèmes d’armes, pour lesquels la défaillance du produit peut provoquer la mort, 
des blessures corporelles ou de graves dommages matériels ou environnementaux («activités à risque élevé»). La société 
AutomationDirect nie toute garantie expresse ou implicite d’aptitude à l’emploi en ce qui a trait aux activités à risque élevé.
Pour des renseignements additionnels touchant la garantie et la sécurité, veuillez consulter la section Modalités et conditions 
de notre documentation. Si vous avez des questions au sujet de l’installation ou du fonctionnement de cet équipement, ou 
encore si vous avez besoin de renseignements supplémentaires, n’hésitez pas à nous téléphoner au 770-844-4200.
Cette publication s’appuie sur l’information qui était disponible au moment de la publication. À la société 
AutomationDirect, nous nous efforçons constamment d’améliorer nos produits et services. C’est pourquoi nous nous 
réservons le droit d’apporter des modifications aux produits ou aux publications en tout temps, sans préavis ni quelque 
obligation que ce soit. La présente publication peut aussi porter sur des caractéristiques susceptibles de ne pas être offertes 
dans certaines versions révisées du produit.

Marques de commerce
La présente publication peut contenir des références à des produits fabriqués ou offerts par d’autres entreprises. Les 
désignations des produits et des entreprises peuvent être des marques de commerce et appartiennent exclusivement à leurs 
propriétaires respectifs. AutomationDirect nie tout intérêt dans les autres marques et désignations.

Copyright 2019–2022, Automationdirect.com® Incorporated
Tous droits réservés

Nulle partie de ce manuel ne doit être copiée, reproduite ou transmise de quelque façon que ce soit sans le consentement 
préalable écrit de la société Automationdirect.com® Incorporated. AutomationDirect conserve les droits exclusifs à l’égard de 
tous les renseignements contenus dans le présent document.
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Forward
This getting started guide is designed to assist the first time user of Do-more! Designer with getting the 
PLC connected and a simple program written.  While this guide is written for the Do-more! BRX series 
of PLC, the steps herein are basically the same for any Do-more! Series PLC, including H2-DM1(E) and 
T1H-DM1(E).

If at any time you find yourself with questions, our technical support team is available to help.  Please see the 
resource guide in the Appendices for more information on the available help resources.

We hope you enjoy programming your new Do-more! PLC.  The Do-more! engine is an incredibly powerful 
processor, we think you will find it capable of nearly any task that you can attempt with it.  

Good luck on your programming journey.  If after you have spent some time with the system you want to 
tell us about your experience, please feel free to tell us in a product review or on our forums!  We love to hear 
customer feedback.
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Overview
The BRX Platform is a Micro PLC system that uses the Do-more! Designer Software version 2.0 or newer 
(ADC part number DM-PGMSW).  The Do-more! Designer programming software package (downloadable 
for free) was developed as a powerful, flexible and easy to use controls design tool.

 
The programming GUI features a user-friendly fill-in-the-blank design for editing ladder logic, making 
complex operations such as PID and motion control easy to setup while minimizing programming time.  A 
built-in simulator allows testing of a program design concept without requiring any external hardware.  This 
will help to reduce programming errors during the development phase of your application. 

Easy to use troubleshooting tools allow you to actually see what is going on in your logic, from single 
stepping through the program one scan at a time to monitoring multiple elements during verification of 
correct program execution. 

For the DirectLOGIC users that want to use the BRX Do-more! Micro PLC Unit (MPU) for projects 
originally written in DirectSOFT, Do-more! Designer software has a built-in DirectLOGIC migration tool 
that will greatly reduce the time to migrate a DirectSOFT program into Do-more! Designer. 

This guide focuses on installing the Do-more! Designer software, establishing a connection to a BRX MPU, 
writing a simple ladder logic program and downloading it to the MPU.  This should help get you familiarized 
with the software and get started utilizing one of the most powerful PLC’s on the market. 

Before You Begin...
Wiring Tools and Hardware

The tools and hardware shown below may be required to make connections to the BRX MPU system.

Wire Strippers 
DN-WS

Screwdriver 
TW-SD-MSL-3 Electrical and 

Signal Wire AC Power Cord 
(Not available from 

Automationdirect.com)
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Programming Connection Options

The BRX MPU allows several built-in programming interface options.  Choose from one of the following 
suggested communication methods for this short step-by-step introduction to the BRX platform.  You should 
have at least one of these programming options ready and available.  

•	 Ethernet port: A standard Ethernet patch cable

Ethernet Cable 
C5E-STPxx-xx

•	 Serial port: Using the 3-pin serial connection on the MPU

Serial Cable
ZL-DB9F-CBL-2P

•	 POM Slot Programming Options

	– USB POM and cable assembly

Programming Cable Assembly
BX-PGM-CBL

	– Ethernet POM and cable

Ethernet POM Module with Cable
BX-P-ECOMLT, C5E-STPxx-xx

	– RS-232 serial POM (RJ12 or 3-pin)

RS-232 Serial POM (RJ12) Module with Cable
BX-P-SER2-RJ12, D2-DSCBL

RS-232 Serial POM (3-pin) Module with Cable
BX-P-SER2-TERM, ZL-D89F-CBL-2P

NOTE: Ethernet POMs, USB and Serial Cables are sold separately.  USB or Ethernet cable is also required for communications 
between PC and CPU.
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BRX Do-more! Designer System Requirements
Do-more! Designer Windows-based programming software is available on CD-ROM or as a FREE download 
at https://support.automationdirect.com/downloads.  Please check our website for this product’s current 
operating systems requirements. 

 

https://support.automationdirect.com/downloads
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Step 1:  Install Do-more! Designer Software
Download the Do-more! Designer programming software (DM-PGMSW) from our website at 
http://support.automationdirect.com/products/domore.html, and launch the install procedure. If you already 
have Do-more! Designer installed, you can just update to version 2.0 or newer to get BRX MPU support.  

The first window that opens displays the Welcome screen seen here.  If there are previous versions of the 
software already installed, this screen will show the version number of the software being replaced as well as 
the one being installed.  Click Next to continue.

An alert window will appear requesting that all anti-virus software be disabled and also reminding the user 
that administrative restrictions may exist.

 

http://support.automationdirect.com/products/domore.html
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The License Agreement window will be displayed next.  Read over the agreement, select I accept the terms of 
the license agreement and click the Next button to continue.

The license agreement may be printed if desired.  The Print function will print a pdf of the License Agreement 
document to your default printer. 

At this point the software will ask a little about you.  Please fill in the user information requested on the 
Customer Information screen and click Next to continue.  
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At this stage, the software will ask which type of install you would like to perform.  The Setup Type window 
seen below gives two options for installation type: Complete and Custom.  

Custom installation allows you to choose which program features to install, whereas Complete installation 
installs all of the program features available. The Complete installation is selected by default and is 
recommended for first-time users. Leave Complete selected (default) and click Next to continue.

The next window to appear is the Ready to Install the Program window.  This window is an alert window, 
cautioning you that the program is about to be installed.  If there are any changes that need to be made to 
the install settings do them now before continuing.  

To review or change any of the previous installation selections, click Back to return to the appropriate 
window and make the change.  If no changes are necessary click Install to begin the installation.
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The pop-up shown here will allow you to choose to install a Do-more! Designer software desktop shortcut  
on your PC.  Click Yes or No and continue with the installation.

The software will now install the needed folders and files while the Setup Status window displays the 
installation progress status.

Once the installation has been successfully completed, the InstallShield Wizard Complete window below will 
open.

Your software is now installed and ready to use.  The installation wizard can now be closed by clicking Finish. 

NOTE: By default the Read Me File and Launch Do-more! Designer now boxes are checked.  Un-check either box should 
you choose not to view the Read Me file and not launch the software at this time.
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Step 2:  Launch the Do-more! Designer Software 

NOTE: For this step, ensure the BRX MPU is not powered up.  Connection to your PC is in Step 3.

NOTE: There are many keyboard shortcuts available in the Do-more! Designer software.  For a list of available short cuts (hot 
keys), view Help topic DMD0361 within Do-more! Designer, or Appendix B of this guide.

After installing the Do-more! Designer software, launch the software by double clicking the desktop Do-more! 
Designer icon. 

You can also launch the software from your PC Start menu or All Programs menu.  If the software link is not 
embedded in the Start menu, use the path: Start > All Programs > Do-more > Designer x.x > Do-more! 
Designer x.x to launch the software.

When Do-more! Designer runs for the first time it goes to the Start Page (area with ‘brick’ wallpaper) and 
the Tip of the Day pop-up comes up by default.  This feature can be disabled by un-checking the Show tips 
at startup box in the lower left corner.  Select Close on the Tip of the Day pop-up when you are finished 
viewing the tips. 
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When the Close button on the Tip of the Day pop-up is pressed, the Select Project window comes up after 
a slight pause.  Here you will select which project to work with - New Offline Project, New Online Project, 
or Browse (for a project not listed).  If you have worked on current projects, they will appear below in the 
Recent Project list.  As this is your initial install your window will be empty.

Press the Close button.  The Launchpad area (on left side of window) is displayed with the Startup Page 
selected.
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From the Start Page, you can select from any of 5 short videos that demonstrate how to use the software and 
explain how the Do-more! technology works. 

Video 1: “Welcome”, welcomes you to the Do-more! Designer Software.  This video familiarizes you with 
the BRX environment showing you how to connect to a BRX MPU, open a project, etc.

Video 2: “Quick Start”, walks you through writing and documenting a simple program and downloading 
it to the BRX MPU.

Video 3: “Troubleshooting”, introduces you to and shows you how to use the troubleshooting and 
debugging tools built in to the Do-more! Designer software.

Video 4: “Architecture”, explains how the Do-more! Technology works.  Understanding the Do-more! 
Technology allows you to take advantage of the built-in features allowing you to create projects easier and 
decreasing the amount of programming time needed.

Video 5: “Helpful Hints”, covers some of the most common BRX MPU programming challenges and 
explains how easily Do-more! Designer can help with these challenges.  

The Video Search & Download Utility opens a search window and download screen.  
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Step 3:  Prepare the Hardware
The “Installation and Wiring” chapter of the BRX User Manual (BX-USER-M) contains detailed information 
for your specific model.

The following summary explains the basic steps needed to get the BRX MPU ready to establish a link so you 
can program and run a project. 

1.	 Installing the BRX MPU on DIN rail: 
a.	Hook rear upper tabs over flange of DIN rail.  
b.	 Rotate the unit down toward the DIN rail, pressing firmly until the BRX MPU snaps securely to 

the DIN rail.

 

     Hook base 
     onto DIN 
rail at top of 
mounting slot.

Rotate base 
into position. Gently push up 

retaining clip to
lock component
onto DIN rail.

1

2 3

2.	 There are three ways to connect to the BRX MPU for programming: 
a.	Using the USB POM with a USB programming cable.
b.	 Using Ethernet cable with built-in Ethernet port.
c.	Using RJ12 Serial POM module and RJ12 programming cable or via the built-in 3-pin serial port 

connector with user supplied cabling. 

Examples of each connection type are shown on the following pages.  

NOTE: All communication connections between the BRX MPU and PC should be completed prior to launching Do-more! 
Designer software.
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A. Connect BRX USB to Computer Using Programming Cable

For USB connectivity the BX-PGM-CBL assembly is required.  This assembly includes one USB POM 
module (BX-P-USB-B) and one 6ft USB-A to USB-B cable (USB-CBL-AB6).

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-
TX/D+

GND

● �Using the Programming Cable 
Assembly (BX-PGM-CBL), install 
the USB POM unit into the MPU 
Plug-in POM slot as shown.

● �Using the USB cable, connect the 
MPU to your computer.

B. Connect BRX Ethernet to Computer Ethernet

There are two options for connecting the BRX via Ethernet to a PC.  One option is to use the built-in 
Ethernet port and connect to the PC via a Cat5 Ethernet cable.  An alternate connection is available by using 
the optional Ethernet POM (BX-P-ECOMLT) module that plugs into the POM slot on the MPU.  Both 
Ethernet options support 10/100Base-T via the RJ45 port.  The Ethernet port supports Auto-Crossover, 
which allows the use of a Cat5 patch or crossover cable.

Built-in Ethernet Port

BRX POM Ethernet (BX-P-ECOMLT)

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-
TX/D+

GND

Built-in Ethernet to PC

POM Ethernet to PC 
(BX-P-ECOMLT)

NOTE: When connecting to a BRX MPU via Ethernet for the first time, you will need to use the NetEdit 3 tool.  Please see your 
device’s user manual for NetEdit instructions.



Chapter 1: Do-more! Designer Getting Started

1-15Do-more! Designer Getting Started Guide, 1st Edition, Rev. B

C. �Connect BRX Built-in Serial Port BRX POM serial port to Computer Serial or USB Port

It is possible to connect to the BRX using the CPUs built-in serial port or by installing the BRX POM serial 
port, BX-P-SER2-RJ12. 

BRX Built-in Serial Port. 

There are two options to consider for connecting the BRX built-in serial port to a PC.  The first option uses 
a ZL-DB9F-CBL-2P to a PC USB port using a USB to Serial adapter (USB-RS232, as shown below).  If the 
PC has a 9-pin serial port connection, you don’t need to use the USB to Serial adapter.  The second option 
(not shown) is to use a user built cable to connect the built-in 3-pin serial port to the PC serial port or USB 
to Serial adapter.

 

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-
TX/D+

GND

ZL-DB9F-CBL-2P

USB-RS232
Use if PC does 
not have a built-in
RS-232 DB-9 port.

EA-MG-PGM-CBL

Serial RS-232 to PC

BRX POM Serial Port 

The BRX Serial POM (BX-P-SER2-RJ12) can connect to a PC by using the D2-DSCBL programming 
cable.  The 9-pin connection of the D2-DSCBL cable can be connected to a serial port on a PC or to a USB 
to Serial adapter (USB-RS232, as shown below).

BX-DM1-10ED1-D

RUN

TERM

STOP

PWR

RUN

MEM

ERR

TX

RX

RS-232/485

SD

PWR IN-

PWR IN+

GND

1C

X0

X1

X2

2C

X3

X4

X5

1C

Y0

Y1

2C

Y2

Y3

RX/D-
TX/D+

GND

Filler
Module

D2-DSCBL

USB-RS232
Use if PC does 
not have a built-in
RS-232 DB-9 port.

POM Serial RJ12 Port to PC

 

BRX 3-Pin Serial Port
ZL-DB9F-CBL-2P

To 3-pin 
TerminalPin # Term Color

2 RXD Brown ....... TXD
3 TXD Red ....... RXD
5 GND Yellow ....... GND
7 RTS Blue

Jumper
8 CTS Violet
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Step 4:  Apply Power to the PLC
WARNING:  Minimize the risk of electrical shock, personal injury, or equipment damage.  Always disconnect the system 
power before installing or removing any system component.

 

-
+

GND
PWR-
PWR+

DC Power In

12–24 VDC
Class 2 or LPS 

User Supplied Power

Once all of the power wiring has been completed and verified, connect the appropriate voltage source to the 
power supply and power up the system.  The BRX MPU will perform a self-evaluation once power is applied.

The following summary explains the basic steps needed to get the BRX MPU ready to establish a link for 
programming and running a project.

NOTE: Please see Chapter 1 of the BRX User Manual for the power wiring diagram corresponding to your specific BRX MPU.
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Step 5:  Establish PC to BRX MPU Communications
The BRX MPU should now be powered up and the programming cable connected. 

NOTE: The following example assumes that you are using the USB POM.

The first time the BRX USB POM is connected to your PC, you should see a message on your PC indicating 
that the driver for the USB device was successfully loaded:

After connecting the USB cable between the MPU and the PC, click the (a) New Link… button in the (b) 
Links windows of the Launchpad area. 
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This brings up the Create New Connection (Link) dialog page and it begins to search for devices on the 
Ethernet, Serial and USB ports. 

When the search is complete, the (a) MPU with the USB POM we are connected to will be displayed on 
the list.  With this MPU highlighted on the list, click on (b) Add New Connection button.  This brings up 
the (c) Connecting to New PLC dialog.  Here you can enter a new (d) Connection (Link) Name, or use the 
default name, My BX-DM1E, and you can enter (e) an Optional Description.  When finished press the (f ) 
OK button.
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1.	 We are now ready to go online with the MPU.  In the (a) Links section 
of the (b) Launchpad, select the (c) USB link; in this example it is called 
BX-DM1E-X 00:3A.  Click on (d) Open button.

2.	 Once connected to the MPU, you may encounter the initialization screen 
shown below.  This will appear on first initialization of a new MPU.  Select 
Set PLC Clock to set the clock in the new MPU to be synchronized with 
your PC clock.  

3.	 The Set PLC Clock option allows you to set the internal, real-time clock of 
the BRX MPU.

  
The Set PLC Clock window has options for (b) Timezone and (a) Daylight Saving Time adjustments.  
Select (c) Set to PC’s current time settings then select (d) Set PLC Clock and Exit.  
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4.	 The option for Setup System Configuration appears next (below).  This allows you to configure 
parameters of the BRX MPU, such as onboard communication port configuration, I/O configuration 
(i.e. high-speed), and mapping.  Select Setup System Configuration.

 
5.	 The System Configuration window appears next with the (a) CPU Configuration selected by default.  

This window and those indexed in the (b) Configuration Entries tree on left, expose many of the 
system operating parameters for your MPU.  For purposes of this introduction we will accept the 
default settings.  Click (c) OK. 
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The Setup System Configuration box reappears.  Select Finish button to move to next step.

  

6.	 The Project Browser (a, b), including the Dashboard (d), will open with the online toolbar (c) 
active.  Notice the status bar indications (e, bottom of window) show the MPU type, memory usage, 
communication status, errors, and mode, etc.  Hovering your mouse over the status bar (e) will 
highlight the items that are selectable.
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If you select one of the items, a new window will open with real-time data and available options.  For 
example, the System Information window seen in the next figure, opens after selecting the memory 
usage values (f ) in the status bar.  This information and much more can be accessed by way of the 
Dashboard.



Chapter 1: Do-more! Designer Getting Started

1-23Do-more! Designer Getting Started Guide, 1st Edition, Rev. B

Step 6:  Verify Hardware Configuration
Next we will verify the hardware configuration.  The BRX series has an auto discover feature that will 
automatically detect installed I/O modules.  You can access the System Configuration in three ways:

1.	 By selecting (a) PLC > System Configuration

2.	 By double clicking on the (b) CPU link under the Configuration tab in the Project Browser

3.	 By clicking the (c) X/Y Configure icon on the project toolbar.
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On the left side of the System Configuration window is an index of topics titled (a) Configuration Entries.  
The (b) BRX Local I/O allows you to view the modules the software has detected.  For this example, we are 
working with a BX-DM1E-10ER3 MPU and no expansion I/O.  This unit has a built-in (c) Ethernet port 
and a (d) USB POM plugged in which show up in the overview graphic.  

The (a) BRX Local I/O graphic area is interactive, like the system Dashboard, and as you hover and move 
across the image (b) “orange” boxes will appear and display information about the highlighted section. 
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Also if the highlighted section can be configured you can click in the highlighted area and a configuration 
screen will pop up.  For example hovering over (b) the built-in analog I/O hot spot,  a pop up will display 
information on how the analog I/O is configured.

After the hardware configuration is verified, select (a) the I/O Mappings option in the Configuration Entries 
index.  This option will display (b) the assigned addresses for the available I/O, as seen below.

These (c) X (discrete input), Y (discrete output), WX (analog input) and WY (analog output) addresses are 
automatically assigned by Do-more! Designer.  You have the option to manually configure these addresses 
by selecting (d) Manual in the Mapping Mode section at the bottom of the window or by right clicking (g) 
BRX Local I/O.  Change default starting address in (e) Edit Base’s Default Map Addresses dialog box.  Click 
(f ) OK when completed to close Edit Base’s Default Map Addresses dialog box. 

The (a) Manual Mode Instructions section, also found at the bottom of the window, details the various color 
indications associated with this mode.

Once the hardware and mapping is configured and verified, click (b) OK to return to the main screen, 
displaying the Dashboard and the Project Browser.
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Step 7:  Create a Ladder Logic Program
In order to create a ladder logic program, you will need to be in Edit Mode.  All programs start with a default 
$Main code block.  We will be adding our ladder logic to this code block.  

We can get to the $Main code block four different ways:
1.	 By selecting the (a) $Main navigation tab.
2.	 By double clicking on the (b) $Main option under the Control Logic section of the Project Browser.
3.	 By selecting (c) View/Edit the Program under the Program section of the Dashboard.
4.	 By using the drop-down menu (d) View > Ladder View, as seen below.

When in (a, b) Edit Mode, (c) Instruction Toolbox options will become active.  The cursor will be positioned 
on (d) Rung #1 and highlighted.
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Rung #1

Place the cursor box in the (a) NOP position on Rung #1.  If the (b) Instruction Toolbox is not open, click 
Edit on the menu and select (c) Instruction Toolbox from the drop-down menu.

 
Now, you are ready to begin entering the example ladder logic.  

Click on the section heading (a) Timers/Counters/Drums and (b) double click or drag/drop the TMR 
instruction. 
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Checking (d) Do not show this again will cause a more concise timer dialog to open on subsequent access 
to the TMR dialog.

 
Access to the more detailed Common Timer Editor dialog can also be controlled from the Editing section (a) 
of the Options dialog accessible from the main Do-more! Designer toolbar.
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Alternatively, you can type “T” while the cursor is on the NOP position and select TMR from the drop down 
menu, then press Enter.

 
Once the TMR is selected, a Timer dialog box appears.

1.	 Set the (a) Timer Struct to T0 
2.	 Enter 03 into the (b) Preset Constant Value for the seconds (s) preset.
3.	 Click on the (c) green checkmark in the upper left corner to accept.

After clicking the checkmark, Rung #1 should show the (d) T0 timer (TMR) instruction with a Preset of 
3.000 seconds.  A user variable can be assigned to the Preset value if needed, to allow the timer preset to be 
set from an external source.

Since a Timer is a structure, it has predefined elements associated with it, such as “Tx.Acc” (accumulated 
time), “Tx.Done” (the completion bit) and “Tx.Timing” (the timer is enabled and timing). 

Therefore, if T0. (the “period” must be used to open drop-down list) is entered into any contact name, the 
Auto-Complete feature of Do-more! Designer will display all applicable bit (Boolean) selections available for 
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that structure.  Selecting (e) the T0.Done element, as seen above, will assign this element to the contact and 
the contact name will be T0.Done. 

This feature works for all structures including: timers, counters, PID loops and strings, to name a few.  Many 
system data types such as, $Main and $FirstScan, as well as those associated with user-created devices like 
ECOM, CTRIO, or SERIO modules also use the Auto-Complete feature.  See the Do-more! Designer Help 
file topic DMD0327 for more information on structure members.

Place the cursor in the (a) leftmost column of rung #1.  Type the nickname T0_Start at the (a) cursor 
position.  The (c) Normally Open contact instruction (b) will be used by default as the nickname is entered.  
Press Enter.

Another option is to (b) click or drag/drop from the Instruction Toolbox (F2 hot key), enter T0_Start for the 
name, and click the (c) green checkmark in the upper left corner.

This will open the Create Nickname dialog seen here.  Select (a) the option …assign to specified element, 
(b) type the desired memory bit for this contact (C1), and select (c) OK to accept.
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Rung #1 should appear as shown below.

With the cursor in the position to the (a) right of contact T0_Start, begin drawing a branch circuit.  Under 
the Edit drop-down menu, select Wire, then select (b) Down.  Notice the shortcuts that are available for 
wire drawing.  The wire could also be drawn using the shortcut: (c) Ctrl+Down Arrow.  The (d) wire should 
now appear in your ladder. 

NOTE: There are also Delete Wire options in the Edit drop down menu that are used to erase any wires not needed.
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Place the (a) cursor in the space to the left of the new line and select another normally open contact.

Type in the nickname (b) T0_Manual and (c) assign bit C2.  Select (d) OK to accept.

 
Rung #1 should look like this:
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Rung #2

Place a normally open contact in the first position of (a) Rung #2.  This contact will be tied to the Done bit 
of timer T0.  Therefore, the name for this (b) contact should be entered as “T0.Done”.  There should be no 
Create Nickname dialog box as seen with the earlier normally open contacts.

Lastly, you will need to add an Out coil to the end of Rung #2.   Place the (a) cursor at the end of the rung 
highlighting NOP and type “OUT” and select the OUT instruction from the drop down menu.  Another 
option is to (b) select the OUT instruction from the Instruction Toolbox under the Coil/Bit Output section. 

Next, choose which bit will be tied to this coil.  Tie this (c) coil to the physical output Y1 by typing “Y1” and 
clicking the (d) green checkmark in the upper left corner. 

 



Chapter 1: Do-more! Designer Getting Started

Do-more! Designer Getting Started Guide, 1st Edition, Rev. B1-34

The ladder program should now look like this:

When either the (a) T0_Start or (b) T0_Manual contact is energized, the timer will begin timing.  When it 
times out, contact (c) T0_Done will energize and the (d) output coil Y1 will turn on.  Note that an END 
instruction is not required.

The (a) yellow bar in the left margin signifies logic that has not been accepted.  So once you have verified your 
logic, click the (b) Accept button in the Project Toolbar to accept the changes.

After selecting “Accept”, the yellow bar should be replaced by green and cyan bars (left margin).  The green 
bar means the project has been accepted but not saved to disk.  The cyan bar (only appears when online) 
means the project has been accepted, but not yet downloaded to the MPU.
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Step 8:  Save Project
Save the project by selecting (a) Save Project from the File drop down menu (Ctrl+S), or save the file under 
a different name or in a different location by selecting the (b) Save Project As option.  You can also save the 
project by selecting the (d) SAVE icon on the Project Toolbar. 

Once you save the project, the green bar on the left side of the ladder will disappear and the cyan bar (c) will 
remain, meaning you have successfully saved the project to disk, but not yet downloaded to the MPU.
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Step 9:  Write Project to the BRX MPU
Now that you have created the example ladder logic program, you can write the program to the MPU.  As 
a quick review, (a) check the status bar at the bottom of $Main window to verify you are Online with the 
MPU.  Also notice the (b) cyan bar to the left of the ladder logic program signifying that your project has 
been accepted, but not downloaded/written to  the MPU.

  
There are several ways to write the project to the MPU.  You can chose (c) Write PLC button from the Project 
Toolbar or select (d) Write to PLC from the File drop down menu (Shift+F9). 
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When the Write PLC button is selected and the MPU is in program mode, the Download Project to PLC 
pop-up window seen here appears.

When the BRX MPU is in (a) Program mode and you click on the (b) OK button, the project is written to 
the MPU.  When the download is complete, the MPU remains in program mode.  In this window, you can 
select (c) to switch the MPU to RUN mode after the download is complete. 

You can also select (d) not to display the Download Project to PLC window if the MPU is in program mode, 
keeping in mind that selecting this option will not download any Memory Image.  Please view the Do-more! 
Designer HELP topics for details on the features available in the Download Project to PLC window.

NOTE: It is good practice to verify that the process you are controlling can be interrupted before downloading a project to 
the MPU.
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If you do not select the option to Switch to RUN mode after the download completes, you can switch to RUN 
mode manually several ways: 

Click on the MODE icon on the Project Toolbar

Select PLC Modes from the PLC drop down menu or use the shortcut, Ctrl+Shift+R.

Click on (a) Program in the Status bar.  This will bring up the Select PLC Mode pop-up where you can change 
the PLC mode by selecting the (b) Run radio button.
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Step 10:  Testing Project Using Data View
With the project successfully downloaded to the MPU and the unit in RUN mode, you can now test the 
function of the ladder program using the Data View tool.

Start by opening a new Data window.  To do this, click on the (a) Data icon on the Project Toolbar, or (b) 
select menu item Debug > Data View > New (Ctrl+Shift+F3).

The Data View window shown below (c) will open.  This window will open in the project browser section 
of the programming window but it can be (d) relocated anywhere on the screen by clicking the title bar and 
dragging it to a new location.
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Now enter the elements that you wish to monitor.  On line one type “C1” under the Element column and 
press Enter.  You will see the C1 change to the (a) nickname associated with it, T0_Start.  On line two (b) 
type the element “C2” (T0_Manual) and on line three (c) type “Y1”.  Notice the three icons (d) at the top 
right in the data window are grayed out.  This will change in the next step. 

With the ladder elements entered into the Data View window, you now need to activate their status.  To do 
so, (a) click the All Status icon on the Project Toolbar, or (b) select Debug > All Status On.  The All Status 
On option will not only activate (c) the Status of the Data View window but also the status of the (d) ladder 
program as seen below.  The timer structure now shows the status of its structure elements, including the 
accumulated value.
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The next step is to enable edits within the Data View window.  To do this, click the (a) yellow box with the 
E found in the top left corner of the Data View window.  The (b) Edits column is now added to the Data 
View window.

 
The Edits column allows you to make changes to the current values of the elements listed. T0_Start’s current 
value is OFF.  Double-click the (c) ON button under the Edits column.  The (d) Write Current Edit and 
the Writes All Edits buttons will appear at the top of the window.  The buttons will write individual or all 
edits, respectively, made in the Data View window to the MPU.

Click the Write Current Edit to PLC button and confirm it.  This will write the new value to T0_Start.  
Once T0_Start changes to an ON state, the timer (T0) will begin to time and quickly reach the preset.  As 
soon as the preset has been met the done bit, T0.Done, will turn ON causing output Y1 to also turn ON, as 
seen on the following page.  Now write an OFF to T0_Start and watch as the timer and Y1 reset.
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With All Status ON, you can view instruction information in the ladder view (below).  For example, on the 
TMR instruction you can see the actual accumulated time while the timer is on, and when the timer is done, 
to mention a few.

Congratulations, you have now programmed, downloaded, and tested a ladder logic program for the BRX 
Do-more! MPU.  Feel free to experiment with a program of your own and please remember that the software 
Help file is an essential tool to use when programming your controller.
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Do-more! Designer Software and Firmware Updates
There will be times when an update is available for the BRX firmware or the Do-more! Designer programming 
software.  The Do-more! Designer software makes it very easy to download the updated files.

By default, checking for updates is done automatically each time Do-more! Designer is started.  Do-more! 
Designer will check for updates to the programming software, the Help file content, Start Page content, 
new firmware for BRX Do-more! and Do-more! controllers and new firmware for CTRIO(2) modules.  An 
Internet connection is required to perform the check and to download the updates.

When updates are available, the user is notified through this dialog:

The automatic check can be disabled by opening the View -> Options menu, select the Global tab and 
uncheck the Automatically Check for Updates on Startup selection.
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To manually check for software or firmware updates, go to HELP -> Check for Updates.

Do-more! Designer Help Topic DMD0310 provides detailed information on downloading the programming 
software updates, firmware updates, Do-more! Designer Help System updates, and HTML/Documentation 
updates.

Updating the Firmware

NOTE: Downloading the firmware files does not automatically update the firmware of the connected BRX PLC.  You must use 
the available tools to update the Operating System and the Gate Array and Loader.  The available tools will indicate when the 
firmware is not up to date in the controller.

There are three ways to access the dialogs needed to update the Operating System and the Booter/Loader.  

The first method is by using the (a) Info icon on the online toolbar.  A second method is by selecting the (b) 
OS or (c) Booter links under the CPU section of the Dashboard.
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The third method is through the menu, PLC -> Update Firmware.

When you select the Info icon on the online toolbar, the System Information utility (below) comes up.  To 
update the controller firmware, use the section under CPU Version Information.  

The CPU section displays the following information:

•	 Do-more!:  The current version of the instruction set in the controller.

•	 OS:  The current version of the operation system in the controller.

•	 Booter:  The current version of boot loader in the controller.

•	 FPGA:  The current version of the Gate Array code in the controller.

•	 Hardware:  The current revision of the controller hardware.

NOTE: An Asterisk (*) next to any of the numbers means that there is an update available for that particular portion of the 
firmware.
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Click the Update button (a) adjacent to the Do-more & OS display to open the Update Operating System 
dialog. 

 
Click the Update button (b) adjacent to the Booter & FPGA display to open the Update Gate Array and 
Loader dialog.

NOTE: If both the Booter and OS need updating, it is recommended to do both updates, starting with the OS.

NOTE: DIP switch #3 (on MPU) is used to Enable/Disable the ability to update the firmware in the controller.  This DIP switch 
must be OFF to allow Do-more! Designer to update the operating system or the gate array.  Please review Do-more! Designer 
Help topic DMD0266 for information on the on-board dipswitches.
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The dialog shown below is displayed when you use the OS or Booter link under the CPU section of the 
Dashboard or you use the menu PLC -> Update Firmware.

The Update Firmware dialog has the necessary tools to download new firmware files from the Web and 
update the connected Do-more! CPU.

The Operating System and Booter sections show the version currently running in the attached Do-more! 
CPU and the latest versions of the firmware and boot loader files that have been downloaded to this PC.

Click (a) Check for New Firmware.  The Live Update tool comes up, which allows you to see if there is a 
newer firmware available, and if so to download the updated files.  The Live Update tool is discussed later in 
this chapter.

Clicking (b) Update PLC Operating System opens the Update Operating System dialog that shows detailed 
information about the attached CPU’s operating system and Do-more! Technology versions and selects the 
latest Operating System firmware file based on the connected Do-more! CPU.  The Update Operating System 
dialog is discussed later in this chapter.

Clicking (c) Update PLC Booter opens the Update Gate Array and Loader dialog that shows detailed 
information about the attached CPU’s Gate Array and Boot Loader versions and selects the latest Boot 
Loader firmware file based on the connected Do-more! CPU.  The Update Gate Array and Loader dialog is 
discussed later in this chapter.

NOTE: If both the Booter and OS need updating, it is recommended to do both updates, starting with the OS.
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Live Update

NOTE: DIP switch #3 (on MPU) is used to Enable/Disable the ability to update the firmware in the controller.  This DIP switch 
must be OFF to allow Do-more! Designer to update the operating system or the gate array.  Please review Do-more! Designer 
Help topic DMD0266 for information on the on-board dipswitches.

Click the Use Live Update to get Firmware button to open the Live Update dialog.  Live Update will 
utilize the Internet connection to check for new firmware files for the Do-more! controllers and the CTRIO 
modules, then download any new files to the appropriate Bin\Images\< Device > folders.

Click the Go! button to check for updated firmware files.  Click the OK button to close the Live Update 
dialog.

NOTE: Live Update requires a functional Internet connection to work.  Make sure the Internet connection is active before 
running Live Update.
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Update Operating System

When the dialog opens it will read the OS Version and Do-more! versions from the currently connected 
controller, and from the latest operating system firmware file.

Current Operating System Information

OS Version - the current version of the operation system in the controller 

Do-more Technology Version - the current version of the instruction set in the controller

New Operating System Information 

OS File - the most up-to-date operating system firmware file in the default firmware folder 

Select - opens a File Open dialog to select an operating system firmware file.  Operating System firmware files 
typically have the following form: “H2DM1x_<major>_<minor>_<build>.os” 

Description - the current version information from the selected file

OS Version - the current version of the operation system in the selected file

Do-more Technology Version - the current version of the instruction set in the selected file

Click the Update! button to begin the update progress.  The last phase of updating the operating system is 
a reboot of the Do-more! controller.  While the controller is rebooting, the normal communication updates 
will fail, and the Link indicator on the Status bar will turn red.  Once the controller has successfully rebooted, 
normal communication updates will automatically resume, and the Link indicator will return to normal.

Click the Cancel button to exit without updating the operating system.
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Update Gate Array and Loader

WARNING:  There is no fail-safe for the Gate Array and Loader update, which means, if the update process begins and 
then fails, ** DO NOT TURN OFF THE POWER**, keep trying the update process until it is successful. If you turn off 
the power without a successful update the controller must be sent back to the factory for repair (use the ‘H/W Repair 
(RMA)’ link at www.hosteng.com to request an RMA number for a Do-more! CPU that fails to update the Gate Array and 
Loader).

When the dialog opens it will read the Gate Array Version and Boot Loader version from the currently 
connected controller and from the latest Gate Array firmware file.

Current Gate Array and Loader Information 

Booter Version - the current version of Boot Loader in the controller

Gate Array Version - the current version of the Gate Array code in the controller

New Gate Array and Loader Information

GA File - the most up-to-date Gate Array firmware file in the default firmware folder

Select - opens a File Open dialog to select a Gate Array firmware file.  Gate Array files firmware file typically 
have the following form: “H2DM1x_<major>_<minor>_<build>.ga”

Description - the current version information from the selected file

Booter Version - the current version of Boot Loader in the selected file

Gate Array Version - the current version of the Gate Array code in the selected file
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Click the Update! button to begin the update progress.  When the Gate Array and Loader update is complete, 
you will see the following window with instructions to power cycle the PLC.

Click the Cancel (previous graphic) button to exit without updating the Gate Array and Loader.

Dashboard 

The Do-more! Designer Dashboard is a graphical representation of the PLC system.  It is used to assist in the 
configuration of the various components of the system as well as for monitoring and troubleshooting after 
it is up and running.  The following pages will be a quick overview on how to use the Dashboard.  Please 
reference Do-more! Designer Help topic DMD0415 for more detailed information.

The dashboard is divided horizontally into three sections, top, center and bottom sections.  The top and 
bottom sections consist of distinct panes each of which contain related items with current status of each.  
These entries (a) are also mouse-over links; as you move your mouse over an entry it will highlight in red 
and a pop-up text box will appear with more detailed information.  Left click a link to open a dialog that 
addresses the configuration of that entry, or opens a monitor tool for that entry.
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Entries (b) that have an orange ( ! ) next to them indicate items that need your attention.  For example, an 
orange (!) adjacent to the “OS: x.y.z” item in the CPU section indicates the firmware in the CPU is older than 
the firmware you have downloaded to this PC.  Click the link to open the firmware update tool.

Some entries will have their text displayed with a yellow background to indicate the item is generating a 
warning message that may need your attention.  For example, if you have Forces enabled and one or more 
items are currently being Forced to a value, the Memory section will display the “x forces active” text with 
a yellow background.  Click this link to open the Configure Forces dialog to see what elements are being 
forced.

Some entries will have their text displayed with a red background to indicate the item is generating a warning 
message that may need your attention.  For example, if an I/O module is reporting an error, the I/O section 
will display the “I/O System Status” text with a red background.  Click this link to open the I/O System View 
to see an overview of the entire I/O system and locate the module that is reporting an error.

The center section contains a series of tabbed (a) graphical representations of the PLC system components.  
The leftmost (top) selection is the local CPU.  There is an additional tab created for each Ethernet Remote 
I/O Slave.  Any time the mouse cursor is in the center section (b) orange outlines (known as hotspots) will 
appear on the sections of the PLC system to indicate there is status information available for that area or 
configuration that can be performed.

Hovering the mouse cursor over any of the hot spots will display a popup that shows the current status of the 
item in that hotspot.  For example, hovering over the DI hotspot (c) will display information on the response 
times configured for the discrete inputs and, if the unit supports high speed inputs, it will display how the 
high speed Counter/Timer functions are configured.
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Left-clicking on the hot spot will display a popup menu that contains links specific to the configuration tools 
and information displays for that item.  For example, left clicking on the AIO (analog I/O) hotspot, displays 
links to view onboard analog I/O values in Data View and a link to configure the analog I/O, as shown below.

Right-clicking on the MPU or an expansion module will display a list of operations that can be performed 
on that module.  For example, right-clicking on the MPU (below) gives the option to Change CPU Type, 
Connect to PLC, or Disconnect from PLC.  The options will vary depending on the MPU family and 
module type.
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Help File
Accessing the Help File  

The software Help file is available as a quick reference or detailed guide to the many features and capabilities 
of the Do-more! Designer software.  This provides comprehensive support for you as a user of not only the 
BRX Platform but also the whole Do-more! product family. 

There are three ways to access the Help File:
1.	 Select the Help File icon from the Project Toolbar.
2.	 Choose Help from the Help menu drop down.
3.	 Use the shortcut F1 or press the(?) button or the Help button on the dialog that you need help with.
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Instruction Set
The following table lists the Do-more! instruction set.  (See Help topic DMD0186 for more on the Do-more! 
instruction set.)

Do-more! Instruction Set
Instruction Name

Contacts

Normally Open

Normally Closed

Leading Edge One-Shot

Trailing Edge One-Shot

Greater-Than-or-Equal-To

Equal-To

Less-Than-or-Equal-To

Less-Than

Not-Equal-To

Greater-Than

Delta

Leading Edge One-Shot on Power Flow

Trailing Edge One-Shot on Power Flow

Invert Power Flow

Coil / Bit Outputs

DEBOUNCE Reduce Discrete Input Chatter

END End Code Block

FLASHER Cycle Output ON/OFF

INI Immediate Discrete Input

ND Trailing Edge One-Shot

NOP Null Operation

OUT Coil Write Bit

OUTI Coil Out Immediate Bit

PD Leading Edge One-Shot

PONOFF Push On/Push Off

RST Reset Bit

RSTI Reset Immediate Bit

RSTR Reset Range

SET Coil Set Bit

SETI Coil Set Immediate Bit

SETR Set Range

SR Shift Register

TIMEDOUT Timed Output

Analog / Process

ALDEV Deviation Alarm

ALHILO High/Low Alarm

ALRATE Rate of Change Alarm

CLAMP Limit Range

DEADBAND Set Outside Deadband

FILTER First Order Filter

Table continued on next page
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Do-more! Instruction Set (continued)
Class Description

INTEGRAT Integrate Over Time

PID Closed Loop Controller

PIDINT Set PID Tuning Constants

RAMPSOAK Ramp Soak Profile

SCALE Scale Value

SLOPE Calculate Slope

TIMEPROP Time Proportional Control

CTRIO

CTAXCFG CTRIO2 Axis Configuration

CTAXDYNP CTRIO2 Axis Run Dynamic Position Mode

CTAXDYNV CTRIO2 Axis Run Dynamic Velocity Mode

CTAXJOG CTRIO2 Axis Jog Mode

CTAXLIMT CTRIO2 Axis Run Trapezoid w/ Limits

CTAXTRAP CTRIO2 Axis Run Trapezoid

CTDYNPOS CTRIO Run Dynamic Position Mode

CTDYNVEL CTRIO Run Dynamic Velocity Mode

CTPLSADD CTRIO Add Entry to PLS

CTPLSEDT CTRIO Edit PLS Entry

CTREGRD CTRIO Read Register

CTREGWR CTRIO Write Register

CTRUNPOS CTRIO Run Position Mode

CTRUNVEL CTRIO Run Velocity Mode

CTTBLADD CTRIO Add Entry to Preset Table

CTTBLCLR CTRIO Clear Table

CTTBLEDT CTRIO Edit Preset Table Entry

CTTBLLD CTRIO Load Table

CTUPDLVL CTRIO Update Level

Date / Time / Calendar

DT2EPOCH Convert Date/Time to Epoch

DTCMP Compare Date/Time

DTDIFF Difference Between Two Dates/Times

DTOFFSET Add Offset to Date/Time

EPOCH2DT Convert Epoch to Date/Time

NETTIME SNTP Client

SETTIME Set PLC Date/Time

Ethernet

DNSLOOKUP Name to IP Address

EMAIL Send Email

PING Ping Ethernet Device

SETUPIP Setup TCP/IP Parameters

SETUPNOD Setup Ethernet Node Parameters

File System

BACKUP Create PLC Image File

FILECLOSE Close File

FILECOPY Copy File

FILEDEL Delete File

Table continued on next page
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Do-more! Instruction Set (continued)
Class Description

FILELOG Log to File

FILENEWFLDR Make a New Folder

FILEOPEN Open File

FILEQUERY Query File or Folder Information

FILEREAD Read from File

FILESEEK Seek to Position in File

FILESYSCMD Perform File System Command

FILETRUNC Truncate File

FILEWRITE Write to File

Hardware / Device

CLOSE Close Device

DEVCLEAR Clear Device

DEVREAD Read to Device Register

DEVWRITE Write to Device Register

HWINFO Get Hardware Information

OPENDEV Open Device

RD Read from Intelligent Module

SETUPSER Setup Serial Port

WT Write to Intelligent Module

High Speed / Axis

AXCAM Axis Electronic Camming

AXCONFIG Axis Configuration

AXFOLLOW Axis Position Following with Offset

AXGEAR Axis Electronic Gearing

AXHOME Axis Perform Home Search

AXJOG Axis Jog Mode

AXPOSSCRV Axis Move to Position Using S-Curve

AXPOSTRAP Axis Move to Position Using Trapezoid

AXRSTFAULT Reset Axis Limit Fault

AXSCRIPT Run a Sequence of Axis Commands

AXSETPROP Set Axis Properties

AXVEL Axis Set Velocity Mode

PWMOUT Pulse Width Modulated Output

TDODECFG Deconfigure Table Driven Output

TDOPLS Load Programmable Limit Switch Table

TDOPRESET Load Preset Table for Table Driven Output

Math

DEC Decrement

INC Increment

LERP Linear Interpolation

MATH Calculate Expression

RANDSEED Random Number Seed

Math Functions

COS Cosine of Radian Angle

ACOS Arccosine in Radians

SIN Sine of Radian Angle

Table continued on next page
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Do-more! Instruction Set (continued)
Class Description

ASIN Arcsine in Radians

TAN Tangent of Radian Angle

ATAN Arctangent in Radians

DEG Convert Radians to Degrees

RAD Convert Degrees to Radians

FRAC Fractional Portion of a Real Number

TRUNC Truncate Real to Whole Number

ROUND Round Real to Nearest Whole Number

LN Natural Log

LOG Log Base 10

PI Return PI

RANDINT Random Integer    

RANDREAL Random Real Number 

REF Read Value Indirectly

ABS Absolute Value

SQRT Square Root

AVGR Average of a Range of Values

SUMR Sum of a Range of Values

MAXR- Maximum Value Across a Range of Values

MINR Minimum Value Across a Range of Values

STDEVPR Population Standard Deviation of a Range

STDEVR Sample Standard Deviation of a Range

MIN Minimum Between Two Expressions

MAX Maximum Between Two Expressions

TICKus Get Microsecond System Timer Value

TICKms Get Millisecond System Timer Value

NOW Get Date / Time Stamp as a 32-bit Integer

TOINT Convert to Integer  

TOREAL Convert to Real

IF If / Else Expression

COUNTIF (EQ, GE, GT, LE, LT, NE) Count If

SUMIF (EQ, GE, GT, LE, LT, NE) Sum If

Misc / Data Manipulation

BCDTO BCD to Integer/Real

COPY Copy Data

DATAINFO Query Information about Data Memory

DECO Decode to Set Bit

ENCO Encode Bit Position

GRAY Gray Code to Integer

INIT Initialize Data

ISCLEAR Is Structure Cleared

MAPIO Map Inputs/Outputs

MEMCLEAR Clear Memory

MEMCOPY Copy Memory Range

MOVE Move Value

MOVEBIT Move Single Bit

MOVER Move Range of Values

Table continued on next page
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Do-more! Instruction Set (continued)
Class Description

PUBLISH Translate from Do-more!

REFWRITE Write Value Indirectly

ROTL Rotate Left

ROTR Rotate Right

SEG Hex/BCD to 7 Segment Display

SETNUMBER Set Numeric Range

SUBSCRIB Translate to Do-more!

SUMBITS Sum Bits

SWAPB Swap Bytes

TOBCD Integer/Real to BCD

Program Control

CALL Call Subroutine

ENDC Conditional End of Code-Block

ENTASK Enable Task

EXIT Exit this program

GOTO Go to Label

HALT Halt program or Task

INTCONFIG Configure Interrupts

INTDECONFIG Deconfigure Interrupts

INTRESUME Resume Interrupts

INTSUSPEND Suspend Interrupts

JMP Jump to Stage

JMPI Indexed Jump

LABEL Program Label

REBOOT Reboot PLC

RESTART Restart Program or Task

RET Return Back to CALL

RETC Conditional Return Back to CALL

RUN Run Program

SG Stage

SGCONVRG Converge Multiple Stages to SG

SGDIVRG Jump to Multiple Stages

SGRST Disable Stage

SGRSTR Disable Range of Stages

SGSET Enable Stage

STOP Switch to Program Mode

SUSPEND Suspend Program or Task

WATCHDOG Force Watchdog Error

YIELD Yield Program or Task

Program-Looping

BREAK Exit Loop

CONTINUE Skip to Loop End

FOR Index Loop

NEXT Index by Step

REPEAT Loop Until Condition is Non-Zero

UNTIL Repeat Until Condition is Non-Zero

Table continued on next page
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Do-more! Instruction Set (continued)
Class Description

WEND While End

WHILE Loop with While Condition is Non-Zero

Protocol-Custom/Ascii

CHECKSUM Checksum Algorithm

OPENTCP Open TCP Connection

PACKETIN Input Data from Packet Device

PACKETOUT Output Data from Packet Device

STREAMIN Stream in Data from Device

STREAMOUT Stream Out Data to Device

TCPLISTEN Start Listening on TCP port

Protocol Standard

DLRX DirectLOGIC Network Read

DLWX DirectLOGIC Network Write

EIPMSG Send EtherNet/IP Message

GSREGRD GS E-Drive Register Read

GSREGWR GS E-Drive Register Write

HTTPCMD Execute HTTP Command

JSONBUILD Build JSON Record

JSONPARSE Parse JSON Record

MQTTPUB IoT Publish MQTT Topics

MQTTSUB IoT Subscribe to MQTT Topics

MRX Modbus Network Read

MWX Modbus Network Write

PEERLINK Share Data w/PLCs

RX Do-more! Network Read

WX Do-more! Network Write

String

STR2INT Convert String to Integer

STR2REAL Convert String to Real

STRCASE Covert String to Upper/Lower Case

STRCLEAR Clear Strings

STRCMP String Compare

STRDELETE Delete Substring

STRFIND Find within a String

STRGETB Get Bytes out of String

STRINSERT Insert Substring

STRPRINT Print a String

STRPUTB Put Bytes into a String

STRSUB Get Sub-String

STRTRIM Trim Whitespace

STRTRUNC Set String Length

Timer / Counter / Drum

CNT Up Counter

CNTDN Down Counter

COMMON_TIMER Common Timer

DRUM Timed/Event/Timed-Event Drum

Table continued on next page
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Do-more! Instruction Set (continued)
Class Description

FREQCNT Frequency Counter

FREQTMR Frequency Timer

OFFDTMR Off Delay Timer

ONDTMR On Delay Timer

RSTCT Reset Counter

RSTT Reset Timer

TMR Timer

TMRA Accumulating Timer

TMRADOWN Accumulating Down Timer

TMRAG Global Accumulating Timer

TMRDOWN Down Timer

UDC Up/Down Counter

UDCG Global Up/Down Counter
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Do-more! Designer Keyboard Shortcuts
The following table lists the keystrokes (also known as Hot Keys or Accelerator Keys) available in the various 
views of Do-more! Designer that can greatly enhance the usability of each view.

Keyboard Shortcuts
Shortcut Action

Ladder View

! Edit Not-Equal-To Contact

< Edit Less-Than Contact

= Edit Equal-To Contact

> Edit Great-Than-Or-Equal-To Contact

Ctrl+A Select All

Ctrl+C Copy into Clipboard

Ctrl+E Toggle Edit Mode

Ctrl+F Open Find Dialog

Ctrl+Shft+F Find Next

Ctrl+K Open Rung Comment Editor

Ctrl+P Print Current View

Ctrl+R Open Replace dialog

Ctrl+V Paste Clipboard into View

Ctrl+W Connect Wire to Output

Ctrl+X Cut into Clipboard

Ctrl+Z Open Edit History

Backspace Delete Instruction to Left then move Edit cursor to Left

Ctrl+Comma Goto Previous Instruction

Ctrl+Delete Cut into Clipboard

Delete Delete

Ctrl+Down Arrow Draw Wire Down

Ctrl+Shft+Down Arrow Delete Wire Down

Ctrl+End Goto Last Rung in Code Block

Ctrl+Shft+End Add from Current Location to End to Selection

Shft+End Add Next Rung to Selection

Enter Insert Row After Block Cursor, or Before Block Cursor if in 
First Column

F12 Goto Element's Output Reference

Ctrl+F2 Edit Positive Differential Powerflow Modifier

Shft+F2 Edit Positive Differential Contact

F2 Edit Normally Open Contact

Ctrl+F3 Edit Negative Differential Powerflow Modifier

Shft+F3 Edit Negative Differential Contact

F3 Edit Normally Closed Contact

F4 Open Contact Instruction Browser

F5 Open Coil Instruction Browser

F7 Open Box Instruction Browser

F8 Accept Modified Rungs

Ctrl+Home Goto First Rung in Code-Block

Ctrl+Shft+Home Add from Current Location to Beginning to Selection

Table continued on next page
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Keyboard Shortcuts (continued)
Class Description

Shft+Home Add Previous Rung to Selection

Ctrl+Insert Copy into Clipboard

Shft+Insert Paste Clipboard into View

Insert Open Insert Rung, Row, Column dialog

Ctrl+Left Draw Wire to Left

Ctrl+Shft+Left Delete Wire to Left

Ctrl-Minus Goto Element's Previous Reference

Ctrl+Shft+Minus Zoom Out

Ctrl+Page Down Goto Next Modified Rung

Page Down Goto Next Rung

Ctrl+Page Up Goto Previous Modified Rung

Page Up Goto Previous Rung

Ctrl+Period Goto Next Instruction

Ctrl+Plus Goto Element's Previous Reference

Ctrl+Shft+Plus Zoom In

Ctrl+Right Draw Wire to Right

Ctrl+Shft+Right Delete Wire to Right

Ctrl+Up Draw Wire Up

Ctrl+Shft+Up Delete Wire Up

Main Programming Window

Ctrl+D Open Documentation Editor

Ctrl+L Open Ladder View

Ctrl+Shft+L Restore Default Window Layout

Ctrl+N Create New Project

Ctrl+O Open Project

Ctrl+Shft+R Open Set PLC Mode dialog

Ctrl+S Save Project to Disk

Ctrl+Shft+S Toggle View's Status On/Off

Ctrl+T Edit Title Page

Ctrl+Y Open Cross Reference View

F1 Launch Contextual Help

Ctrl+Shft+F2 Open Change Value dialog

Ctrl+ShftF3 New Data View

Ctrl+F9 Read Project from PLC

Shft+F9 Write Project to PLC

F9 Open Element Selection Tool

Data View

Ctrl+Shft+A Sort Elements Ascending

Ctrl+C Copy into Clipboard

Ctrl+ShftD Sort Elements Descending

Ctrl+V Copy Clipboard into View

Ctrl+X Cut into Clipboard

Ctrl+Delete Cut into Clipboard

Delete Delete

Ctrl+Enter Insert Element with Next ID

Ctrl+Shft+Enter Structure Field: Insert Element with Next Field 
Structure: Insert Structure Fields

Table continued on next page
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Keyboard Shortcuts (continued)
Class Description

Ctrl+F2 Modify Element or Edit Cell

F2 Modify Element or Edit Cell

Shft+F6 Move to Format Selections

F6 Move to Format Selections

Shft+F9 Write Value to PLC

Ctrl+Insert Copy into Clipboard

Shft+Insert Paste Clipboard into View

Insert Insert Row

Project Browser

Ctrl+C Copy into Clipboard

Ctrl+V Copy Clipboard into View

Ctrl+X Cut into Clipboard

Ctrl+Delete Cut into Clipboard

Delete Delete

Ctrl+Insert Copy into Clipboard

Shft+Insert Paste Clipboard into View

Insert Open Create New Code-Block dialog

Rung Comment Editor

Ctrl+A Select All

Ctrl+F Goto Comment for Rung

Ctrl+G Goto Comment for Rung

Ctrl+End Goto Last Rung in Code Block

Ctrl+Home Goto First Rung in Code-Block

Ctrl+Page Down Go 5 Rungs Forward

Ctrl+Page Up Go 5 Rungs Back

Cross Reference View

Ctrl+F Open Find Dialog

Ctrl+Shft+F Find Next

Ctrl+P Print Current View

Trend View

F2 Open Add / Remove Elements dialog

Element Documentation Editor

Ctrl+C Copy into Clipboard

Ctrl+F Open Find Dialog

Ctrl+Shft+F Find Next

Ctrl+P Print Current View

Ctrl+V Copy Clipboard into View

Ctrl+X Cut into Clipboard

Ctrl+Delete Cut into Clipboard

Delete Delete

Ctrl+Insert Copy into Clipboard

Shft+Insert Paste Clipboard into View

Change Value Dialog

Ctrl+F9 Read Value from PLC

Shft+F9 Write Value to PLC

Table continued on next page
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Keyboard Shortcuts (continued)
Class Description

Print Preview

Page Down Next Page

Page Up Previous Page
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Tips and Tricks
C-more tag import

To easily get your tags from a Do-more! Designer Project into a C-more HMI, in Do-more! Designer go to 
File –> Export -> Element Documentation.  Pick C-more Do-more! Driver Format WITH Structure Fields.

The most common issue with importing tags into a C-more HMI is that you have not given all of your 
memory elements Nicknames.  Without Nicknames C-more cannot make a proper tag out of your memory 
fields.

Pointers, Indexing and Arrays

In order to utilize a memory element as an array, it must be a Memory Block.  Heap Items are singeltons and 
cannot be utilized as an array.  To see what elements can be used as an array or to create a custom item, go to 
System Configuration -> Memory Configuration -> Memory blocks tab.

Addressing a Memory Block as an array is simple.  Place brackets [ ] after the Memory Block name and use 
a V-memory element such as V0 as the index.  IE D[V0], N[V5], UDT[V0], etc.

A handy trick for knowing how large the array is without hardcoding values is to use the DATAINFO 
instruction.

Bit of Word, Data type conversion and Casting

Getting bits out of a word in Do-more! Designer is done with a method called Casting.  More information 
on Casting can be found in Do-more! Designer Help Topic DMD0309.

The basics of Casting a memory element are to use a “:” and an identifier or for Bit of Word, a number.  IE 
D0:1 is bit 1 of memory element D0.  All Bits start at zero.

To simplify Casting, you can use the Cast Builder.  When on a field that supports a memory element, press 
the F9 key.  Type your Source Element in the appropriate field and then in the bottom right corner, press the 
“Show Cast Builder” button.  Click the appropriate radio buttons and then press “Select”.  It is that easy to 
cast a memory element.

Other methods for doing memory type conversion is by using the ladder commands PUBLISH and 
SUBSCRIBE.  These will allow you to convert large areas of memory at once which is useful when you are 
talking to a Modbus or DirectLogic device that utilizes untyped memory.

Formatting Date and Time on an HMI with String Scripting

If you want your date and time to look nice on your HMI, put the data into a string using STRPRINT and 
the string scripting language.  See Do-more! Designer Help Topic DMD0168 for a list of all string scripting 
commands.

MATH, Logical Operations & statistical functions

The Do-more! MATH instruction is a very powerful feature.  Do-more! Designer Help Topic DMD0085 
covers the lists of functions that are available.

In addition to doing Arithmetic and Trigonometry, it can also do Logical and Bitwise operations.  A few 
minutes perusing this help topic can save you a lot of time.
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The most common issue when doing Math with a Do-more! processor is knowing that you must promote the 
equation to Real (Floating Point) if you are using integers with a Real result.  If the equation is integers, but 
you wish to have a result that is a Real number you must use TOREAL() or add a decimal point to one of the 
numbers; IE 2.0.  See Help topic DMD0085 for more information on promoting numbers to Real format.  

Simulation and PID Simulation

Do-more! Designer software comes with a separate Do-more! simulator application that runs the same 
Do-more! control engine that is in the Do-more! CPUs. You can connect/disconnect and upload/download 
to the simulator as you would with a Do-more! CPU. There is even a Run/Term/Stop mode switch and LED 
indicators for power, Run and communication activity. This is a great tool to test your code before you ever 
load it into your system.

The Simulator also has the ability to do simple PID simulation to learn how PID works!

See Do-more! Designer Help Topic DMD0234 for more information.

Symbolic Constants

Do-more! Designer supports the use of Symbolic Constants.  A Symbolic Constant is where you assign a 
nickname to a hard coded value.  IE Sunday = 0, Monday = 1, Tuesday = 3, etc.  Do-more! Designer Help 
topic DMD0276 has more information on symbolic constants.

To assign a Symbolic Constant, go to Tools -> Documentation Editor and then press the “Symb” in the 
toolbar of the Documentation Editor tab.  This can help make your program much easier to read and 
navigate.

You can add a nickname to a memory location that has a cast.  For example you have a double word signed 
number in D100 nicknamed “Dancer” for your dancer position.  If you wanted to know that it was a negative, 
you could use D100:31 which is the sign bit for D100.  If you were to nickname D100:31 “Dancer_Neg” 
you could use this nickname throughout your program and it would always refer to D100:31.

Start Page replacement

You can attach documents to your project to replace the content of the Start Page on a project-by-project 
basis. This can be a PDF, Excel spreadsheet, JPG, etc. A good example of this is the PID1.dmd example 
project found in the Examples folder in Do-more! Designer.

Moving Communications links to another PC

You can move your communications links from one PC to another by copying the DmDComm.RST file that 
is located in the Do-more\Designerx_x\Bin\ folder.

Troubleshooting email with DMLogger

In your Do-more! Designer ladder project, turn $EnableMsgDump bit ON & start Do-more! Logger from 
Applications window in the Launchpad to troubleshoot email.  This will send the server messages to your PC 
so that you can see exactly where it is getting stuck at.

The DMLogger utility can also be useful for troubleshooting by placing STREAMOUT instructions in your 
ladder code to send messages to the utility to let you know what is happening at various times.
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Importing Program segments

Use the #import mechanism in your Import Program text file so you can modularly create projects from 
different source files.  So MyProject.TXT could contain just 4 lines:

#include “SysConfigXYZZY.txt”
#include “MachineControl.txt”
#include “Library\NonLinearControlLibrary.txt”
#include “Library\CalendarLibrary.txt”
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Online Resources
AutomationDirect provides extensive FREE online services and rich resources from free online tech support 
to training and how to videos as well as online forums. The following are the contact URLs for each of these 
resources. Thank you for choosing AutomationDirect for your automation needs. 

AutomationDirect Technical Support

http://support.automationdirect.com/techcontact.html

AutomationDirect BRX & Do-more! Videos

https://www.automationdirect.com/do-more/brx/Support/index

Interconnecting Automation Online BRX Training

http://www.interconnectingautomation.com/onlinecourses/course/index.php?categoryid=17 

AutomationDirect Forum

https://forum.automationdirect.com/

Do-more! Designer Software

http://support.automationdirect.com/products/domore.html

BRX, H2 & T1H Do-more! Manuals and Inserts

https://cdn.automationdirect.com/static/manuals/index.html#domore

BRX 2D CAD drawings

http://ftp.automationdirect.com/support/drawings/brx.zip

NOTE: 3D Drawings can be found by browsing to the Product on the AutomationDirect website and 
selecting the STEP file download link.

H2 & T1H Do-more! Autocad drawings

http://ftp.automationdirect.com/support/drawings/domore.zip 

http://support.automationdirect.com/techcontact.html
https://www.automationdirect.com/do-more/brx/Support/index
http://www.interconnectingautomation.com/onlinecourses/course/index.php?categoryid=17
https://forum.automationdirect.com/
http://support.automationdirect.com/products/domore.html
https://cdn.automationdirect.com/static/manuals/index.html#domore
http://ftp.automationdirect.com/support/drawings/brx.zip
http://ftp.automationdirect.com/support/drawings/domore.zip
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HOST Engineering Main Website

http://www.hosteng.com/

HOST Engineering BRX FAQ’s

http://www.hosteng.com/FAQFiles/Do-more.htm 

HOST Engineering Forum

http://forum.hosteng.com/

HOST Engineering Do-more! Designer Revision History

http://www.hosteng.com/SW-Products/Domore%20Designer/DmDesigner.htm

HOST Engineering BRX Firmware Revision History

http://www.hosteng.com/HW-Products/DM1/BX-DM1_RevHistory.htm

HOST Engineering H2 Firmware Revision History

http://www.hosteng.com/HW-Products/DM1/H2-DM1_RevHistory.htm 

HOST Engineering T1H Firmware Revision History

http://www.hosteng.com/HW-Products/DM1/T1H-DM1_RevHistory.htm 

HOST Engineering Do-more! Training Slides

http://www.hosteng.com/FAQFiles/TechSlides/TechTrainingSlides01.html

HOST Engineering BRX Specific Training Slides

http://www.hosteng.com/FAQFiles/BRXTraining/BRXTechTrainingSlides.html

http://www.hosteng.com/
http://www.hosteng.com/FAQFiles/Do-more.htm
http://forum.hosteng.com/
http://www.hosteng.com/SW-Products/Domore%20Designer/DmDesigner.htm
http://www.hosteng.com/HW-Products/DM1/BX-DM1_RevHistory.htm
http://www.hosteng.com/HW-Products/DM1/H2-DM1_RevHistory.htm
http://www.hosteng.com/HW-Products/DM1/T1H-DM1_RevHistory.htm
http://www.hosteng.com/FAQFiles/TechSlides/TechTrainingSlides01.html
http://www.hosteng.com/FAQFiles/BRXTraining/BRXTechTrainingSlides.html
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Notes: 
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Generate DMLoader Image
The Generate DMLoader Image utility is intended to be used by OEMs to help them handle updating the 
Do-more! PLC in machines that they have built. To that end, this utility is used to build a single file that 
contains any mix of the System Configuration, the Ladder Logic, the Documentation, the PLC’s memory 
contents, and the PLC firmware of a Do-more! CPU. This file will then be used by DMLoader to update one 
or more Do-more! PLCs without having to use the Do-more! Designer PLC programming software.

NOTE: To generate a DMLoader image, you must be connected to a Do-more! PLC. The utility cannot generate an 
image from just the program file.

After opening the Do-more! Designer project and establishing the online communication session with the 
Do-more! CPU, use the File-> Export-> Generate DMLoader Image menu selection to begin. 
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As you progress through the various selections, this utility will gather the required information from the 
currently open Do-more! Designer project and from the Do-more! CPU in the current online session. As you 
enable a selection you will be prompted for any additional information that is required by that selection.

DMLoader Image Passwords

The Generate DMLoader Image utility will maintain password protection to protect intellectual property in 
the image file and/or the CPU itself. 

The DMLoader Image Password allows a password to be used on the image file that will be generated. 
DMLoader Image Passwords must be 4 to 8 characters in length with no embedded white-space characters. 
Passwords are also case sensitive. Leave this field blank if you DO NOT wish to include a password on the 
image file itself.

The Comm Session Password allows DMLoader to correctly handle CPUs with password protection 
enabled by requiring the destination CPU’s password be included in the image file so that it can establish 
a communication session with the destination CPU. The password is encrypted when saved as part of the 
image file. Comm Session Passwords must be 4 to 8 characters in length with no embedded white-space 
characters. Passwords are also case sensitive.

Vendor Codes

The Generate DMLoader Image utility provides a way to use Vendor-supplied values to make sure that the 
updates are being downloaded to the correct destination CPU. 

The $ProductID field contains an 8 digit Hex value. It can be set to operate in one of the following three ways:

•	 Off – download the image value regardless of the values in DST387 in the destination CPU.
•	 Set – overwrite the value in DST387 with the specified value regardless of the current value in that 

register location.
•	 Require – read the value is DST387 from the destination CPU and require that the value read from 

the CPU match the value specified before the image can be downloaded.

NOTE: When you click Generate Image, a Warning message will be displayed if the value specified in this 
field does not match the value currently in DST387 of the source CPU. You should consider adding a rung 
of ladder logic to $tFirstScan that sets the $ProductID value so that this value is always in the expected 
location.
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The $ProductVersion field also contains an 8 digit Hex value in the form of MMmmBBBB where MM is 
the major version, mm is minor version and BBBB is the build number. This field can be set to operate in 
one of the following three ways:

•	 Off – disregard this field. 
•	 Set – set the value in DST388 to the specified value regardless of the current value in that register 

location.
•	 Check – read the value is DST388 from the destination PLC and compare that value to the value 

specified. These values are NOT required to match to allow the image to be downloaded. If the values 
do not match a message to that effect will be displayed.

NOTE: When you click Generate Image, a Warning message will be displayed if the value specified in this 
field does not match the value currently in DST388 of the source CPU. You should consider adding a rung 
of ladder logic to $tFirstScan that sets the $ProductID value so that this value is always in the expected 
location.

PLC Operating System

The Generate DMLoader Image utility can include a copy of the firmware that is currently running in the 
connected Do-more CPU so that DMLoader can update the destination CPU’s firmware as part of the image 
download process.

At the time the Update PLC OS selection is enabled, the utility will read the current firmware version 
from the connected Do-more CPU and it will then search the Do-more Designer’s firmware folders for the 
operating system firmware file that best matches the firmware version read from the CPU. The full pathname 
of the file that best matches will be displayed. 

If no matching firmware file is found, or if you want to use a different operating system firmware file, click 
the Select File button to open a File Open dialog that will allow you to browse for a different operating 
system firmware file.

Program System Configuration, and Documentation

When the Program System Configuration, and Documentation selection is enabled the following parts of 
the currently open project will be included in the image:

•	 All of the Project’s code-blocks, which include the System Programs and Tasks and all User Programs 
and Tasks. 

•	 The System Configuration, which includes the following:
	– CPU Configuration (the TCP/IP configuration of the on-board port will NOT be included, the 

Destination’s CPU’s TCP/IP configuration can be done by DMLoader).
	– I/O Configuration
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	– Module Configuration
	– Device Configuration
	– I/O Mapping
	– Memory Configuration

•	 All of the Project’s Documentation, which includes the Element Documentation and the Rung 
Comments.

If this selection is NOT enabled, the Program, System Configuration and Documentation in the destination 
PLC will NOT be changed when DMLoader downloads this image file.

Retentive Memory Image

When the Download Retentive Memory Image selection is enabled a check is made to see if a retentive 
memory Image already exists for the project. If one exists its contents will be included in the DMLoader 
image. 

If none is found you will be prompted to run the Memory Image Manager to create one. Upon returning 
to this utility you will prompted to include contents of the just-created retentive memory image in the 
DMLoader image file.

Password Configuration

When the Download Passwords selection is enabled all of the User Account information will be included 
in the DMLoader image file.

If this selection is NOT enabled, the User Account information in the destination PLC will NOT be changed 
when DMLoader downloads this image file.

Vendor Banner and Update Instructions

These two fields allow the user to supply a vendor-specific banner graphic and/or vendor-specific system 
update instructions that will be displayed in DMLoader when it opens this image file. 

The banner is a 690 x 65 pixel BMP image that is centered in the top section of DMLoader when it opens 
this image file. When the Use Banner selection is made the Select File button is enabled which will open a 
dialog where the user can browse for the BMP file that will replace the default graphic. The selected file will 
be added to the image file at the time it is selected.
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The area circled in red in the image below is the banner area of DMLoader. The user-supplied banner will be 
centered in that area. If the user-supplied banner is too large for the area it will be clipped, it will NOT be 
resized to fit.

The instruction file is a text file that will displayed in the bottom section of the initial screen of DMLoader 
when it processes this image file. This instruction file can contain written instruction that the operator will 
use when using DMLoader to update a CPU.

When the Use Instruction File selection is made the Select File button is enabled which will open a dialog 
where the user can browse for a TXT or RTF file that will replace the default instruction file.

The area circled in red in the image below is the instruction text area of DMLoader. 
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Generate the Image File

Click the Generate Image button when all of the desired selections are made to specify the file name for the 
DMLoader image file. When the file generation is complete the following dialog is displayed which gives you 
the following options:

Open directory containing image file – will open a Windows Explorer instance of the directory where the 
newly generated image is stored and the image file itself will be highlighted. This useful if you need to access 
this image file at this point to distribute it.

Open directory containing DMLoader.exe – will open a Windows Explorer instance of the directory where 
the DMLoader.exe is installed with DMLoader.exe highlighted. This useful if you need to access this utility 
to distribute it.

Open DMLoader download web page – will open a web browser instance pointing to the location 
on the Host Engineering website where an installable version of DMLoader is located. The URL is 
www.hosteng.com/sw-products/dmloader.html.

Close – if you are done with this utility.

Click the Don’t show this again option to prevent this dialog from appearing the next time you run the 
Generate DMLoader Image utility.

http://www.hosteng.com/sw-products/dmloader.html
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DMLoader—Do-more! Loader
The DMLoader utility will use an image file built by Generate Do-more! Loader Image in the Do-more! 
Designer software to update a Do-more! CPU with the contents of that image file. DMLoader can use a 
USB, Serial, or Ethernet connection to the destination Do-more! CPU to perform the update.

DMLoader has its own website that you can use to download the utility: www.dmloader.com.

When DMLoader opens, you will be prompted for the DMLoader image file to open. If the image file was 
created with a password, you will be prompted to enter that password before the file can be opened.

After an image file is selected and successfully opened, the main DMLoader dialog will be displayed. The 
image below has the default Do-more! Loader banner at the top and the default instructions in the bottom 
section. If the image was created with custom banner and/or instructions these would be displayed instead.

Click the Load Image button to open a different DMLoader image file.

Click the Open Instructions in external app button to open the instructions in the computer’s default 
application for .RTF files; this could be Notepad, Wordpad, Microsoft Word, etc. This allows you to have the 
instructions available on-screen when you move to the next section of the DMLoader process.

Once the correct image file is open, and the instructions are where you want them, click the Next button 
move to the next section.

Establish Communication Link to the Destination CPU

This section of the dialog will establish the required communication link to the destination CPU. You can 
elect to use the USB or Serial or the Ethernet port (if available) on the destination CPU to establish the 
communication link. Once the connection port is selected and configured (if necessary) then click the 

http://www.dmloader.com
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Test Link to Continue button to verify that the link is functional before you can continue to the next section 
where the update will be performed.

Step 1: Select the communication port to use

USB – select this option to use the USB port to perform the update operation. If the USB cable was 
connected when DMLoader was started, the destination CPU’s USB address will already be in the list of USB 
devices found. If multiple Do-more! CPUs are displayed highlight the one you want in the list.

Scan for Devices – click this to re-scan the USB port to find a newly connected Do-more! CPU.

NOTE: If the connected Do-more! CPU is NOT in the list of USB devices after a re-scan operation make sure 
that no other application, such as Do-more! Designer, is currently using that USB connection to the CPU.

Serial – select this option then provide the following:

Serial Port – will list the serial ports that are configured on this computer, for example: COM1, 
COM2, etc.
Baud Rate – 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200, 300
Parity – None, Odd, Even
Data Bits – 5, 6, 7, 8
Stop Bits – 1, 1.5, 2
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Ethernet – when this option is selected, DMLoader will query the network for Do-more! CPUs that are 
currently connected to the network. If the destination CPU is new (and does not have a TCP/IP configuration) 
or has an incorrect TCP/IP configuration, this can be addressed in the next step.

Select the desired destination CPU from the list and it’s currently configured IP address will be 
displayed in the IP Address field.
Scan for Devices – to perform the network query to scan for Do-more! CPUs.

Step 2: Test the communication link to verify connectivity

After the port has been selected, click Test Link to Continue to validate the communication link. If the 
validation process is successful DMLoader will read the following information from the attached Do-more! 
CPU:

Type – displays the type of controller hardware and identification

PLC Type – displays the type of controller hardware
H2-DM1 – DL205 Series Do-more! controller
H2-DM1E – DL205 Series Do-more! controller with on-board Ethernet
T1H-DM1 – Terminator I/O Series Do-more! controller
T1H-DM1E – Terminator I/O Series Do-more! controller with on-board Ethernet
DM-SIM – Do-more! Simulator

Serial Number – the 12 digit serial number of the controller 
Do-more! controllers without on-board Ethernet – this is a serialized number assigned at the 
factory
Do-more! controllers with on-board Ethernet – this is the MAC address of the Ethernet port
DM-SIM – this is the MAC address of the primary Ethernet adapter in the PC running the 
Do-more! Simulator

Mode – displays the current PLC mode information

Keyswitch – the current position of the front panel keyswitch 
RUN – the keyswitch is in the RUN position
TERM – the keyswitch is in the TERM position
STOP – the keyswitch is in the STOP position 

PLC Mode – displays the current PLC mode 
Run – the controller is running the project
Program – the controller is not running the project
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Optional Step 3: Setting up the TCP/IP configuration for a Do-more! CPU that has an 
on-board Ethernet port

Node and IP Configuration – displays the current Node configuration and the setup of the on-board 
Ethernet port (on models that have them). These values are initially configured by the NetEdit utility. 
The values of the fields are also stored in the controller’s memory in these locations: $IPAddress (DST18), 
$NetMask (DST19), $Gateway (DST20).

Click the Set Node and IP Configuration button to open a dialog that will allow you to change these entries. 

NOTE: The ability to change the TCP/IP configuration of a Do-more! CPU through its USB or Serial port is a 
convenient way to set the TCP/IP configuration of a controller that is not configured to be part of the local network.

Module ID – the ID can be any positive constant number
Name – the Name can be any 255 character combination of alphanumeric and punctuation 
characters. The Module ID and Names entered must be unique on the network where the controller 
will be connected.
Description – the Description can be any 255 character combination of alphanumeric and 
punctuation characters.
The TCP/IP Address information entered in the following three fields must be valid for the network 
where the controller will be connected. For Do-more! controllers that do not have an on-board 
Ethernet port these fields are not used for configuration purposes, but the data in these fields can still 
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be used for identification by storing values in their associated status memory locations: $IPAddress 
(DST18), $NetMask (DST19), $Gateway (DST20).
IP Address – can be any valid TCP/IP Address The IP Address entered must be unique on the 
network where the controller will be connected
Subnet Mask – can be any valid TCP/IP Subnet Mask
Gateway – can be any valid TCP/IP address of a network Gateway
After the communication link is established click the Next button to move to the final section where 
the update is performed. At this point a final check is made of the communication link to make sure 
that the on-screen selections still are still valid for the Do-more! CPU that is physically connected. 
If at this point the connected CPU does not match the on-screen selections an error message similar 
to the following is displayed:

Perform the Update

The final step is the actual downloading of the image contents to the destination CPU. The left-side control 
will display a list of the operations that will be performed based on the contents of the image file that was 
opened. The right-hand control will display the log entries generated by each step of the update process.

Click the Start Update button to begin the update process, the current step in the process and a progress 
indicator for that step are displayed to the right of the button.
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Once the update process concludes, you can use the Back button to return to the previous step and select a 
different Do-more! CPU to update, or click Close to exit DMLoader.
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